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Introduction
smartFEM is used for simulation electrical machines using alphanumeric respectively graphical
representation and for documentation of the calculated characteristics. For this purpose of FEM
simulations and analyses, smartFEM uses an FE program called FEMAG, developed by Prof. Dr.-Ing.
Konrad Reichert. Numerical techniques are used to solve static electromagnetic field problems by FEM
and analytical methods.
The following machine models (motors and generators) can be simulated by using smartFEM:
-

Permanent magnet brushless DC motors (internal/external rotor) (BLDC)
Permanent magnet brush DC motors (internal rotor)
Permanent magnet linear motors
Synchronous reluctance motors
Switched reluctance motors
Universal motors
Magnetization of permanent magnet internal rotors

smartFEM was developed using Microsoft® Visual Studio® .NET and it runs on desktop computers with
following installed Microsoft® Windows operating systems:
-

XP Professional Edition SP 2
VistaTM Professional
Windows 7, 8, 10 (32 and 64 Bit)

Delivery:
1 USB-Stick as used as dongle containing the following files:
-

xxx.license

License to be loaded in smartFEM License Control

-

setup.exe
smartFEM.msi

-

UserGuide_en.pdf
Topologies_en.pdf

Application for starting the installation manually
Installation package (including a FEMAG version suitable for smartFEM
version)
User guide
Description of rotor and stator topologies
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1 Installation
1.1
.NET Framework
Microsoft® .NET Framework 4.0 is required prior to installation of smartFEM. smartFEM issues a
verification notice if the required installation is missing. A version can be downloaded from the
Microsoft® Download Center and installed.
1.2
smartFEM
Insert the supplied USB stick into the computer, select the "Start" button from the Windows start menu
and enter the USB drive letters followed by the string "\:setup.exe" in the input field. For delivery by
email, enter the location of the decompressed file "setup.exe"

Fig. 1: Window for "Program/File search" - start setup.exe

After pressing the “Return” button, the installation program starts and the user will be prompted for all
the necessary input data.

Fig. 2: Installation of smartFEM
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Following directories and files are created during the installation process:

Fig. 3: Program files directory

The directories contain:
... \ smartFEM

the smartFEM.exe program, related DLLs and user guides
(*.pdf)

... \ smartFEM \ Batch

templates for performing batch calculations.

... \ smartFEM \ ElTopology

topologies of power electronics for dynamics simulation.

... \ smartFEM \ Material Explorer

program and configuration file for describing and maintaining
material data "Material Explorer".

... \ smartFEM \ Materials

material files

... \ smartFEM \ Femag

the program wfemag.exe 1)

... \ smartFEM \ Topology

dll’s for rotor and stator topologies

1)

Note: For installation under Windows 7, the directory C:\Program Files\...\smartFEM\Femag must
be parameterized with wfemag.exe for writing accesses, as wfemag.exe creates temporary
files. If necessary, this directory has to be copied to a user-specific area. smartFEM can
also be installed on any other drive and/or folder which can be accessed by user.

The user-specific smartFEM configuration file “user.config” is stored in the current user directory.

Fig. 4: User-specific files directory
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Each time when smartFEM is started, a log file named “smartFEMLogFile.txt” is created and saved in
the directory “C:\Users\User\AppData\Local\Temp\”. In it is information stored if problems occur.

Fig. 5: smartFEM log file

To repair or delete smartFEM, run setup.exe and
make the appropriate selection.
Only those files are be deleted which were
created during the installation of smartFEM

Fig. 6: Repair or delete smartFEM

14

smartFEM

2 Start and Settings
2.1

Start

smartFEM is accessed via the Windows "Start" menu buttons
"All Programs" → "smartFEM" → "smartFEM".

Fig. 7: Start of smartFEM

A start screen appears. The buttons "Help" → "About ..." display various information about the
installed smartFEM version.

Fig. 8: smartFEM start screen - Information about the installed smartFEM release
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2.2

Registration and license information

After the installation, smartFEM is available to the user unrestricted for 30 days. Subsequently no further
data storage functions can be performed.
Customers who have purchased a time-limited or unlimited software user license may alternatively use
these as follows:
a)

Attaching the license to a USB stick. This allows smartFEM being installed on several
computers and it can be used after inserting the USB stick on the respective computer.
elmoCAD supplies an USB stick as standard with saved smartFEM software and license
files.

b)

Attaching the license to the MAC address of the computer, hard disk or network domain
as per agreement:
• Create a license file through "License Control" → "Write License Data"
• Send the generated license file by e-mail to info@elmocad.de
• Read the activated license file activated by elmoCAD and returned by e-mail through
“Help” → “About” → “License Control” → “Load”

Fig. 9: Loading of the license file
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2.3

Settings

2.3.1

smartFEM

Settings for program and data directories, etc. are displayed via the buttons "Tools" → "... Settings" and
can be adjusted.
2.3.1.1

Folders: Settings of directories

-

Geometry Topology Folder

DLL files for rotor and stator topologies

-

Material Files Folder

files for material data

-

FEMAG Exe for smartFEM

The FEMAG version, installed together with smartFEM,
by which all smartFEM simulations can be calculated.

-

User FEMAG Exe File

a FEMAG version used for additional user-defined
calculations. This version can be different from the one
used by smartFEM.

-

Default Working Directory

Current working directory, where design data and
calculation results are stored.

-

Electronic Topology Folder

DLL files for electronic circuit topologies

Fig. 10: Tools - smartFEM Settings - Setting the directories
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2.3.1.2

Saving: Settings for saving models

Fig. 11: Tools - smartFEM Settings - Storage of the model data

All model data incl. calculation results are saved in a XMLformated file with name *.mot
-

"Automatic Adding Extension to File End"
"_" and an ascending number are attached to the file name for each
storage process i.e. filename_1.mot

-

"Dynamic Calculation - Save Only Last Period"
Only the result data corresponding the last BEMF period is stored in
dynamic calculations.

-

"Auto Saving After"
Automatically saves the model data after each selected calculation
process:
- Pre-processing
- Cogging and BEMF Calculation
- Nominal Torque and Inductance Calculation
- Dynamic Calculation
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2.3.1.3

General: General Settings

Fig. 12: Tools - smartFEM Settings - General settings

Topology Window:
-

"Geo Accuracy"
All geometry points of drawing objects i.e. lines, arcs, etc., which are lying in
a circle with defined diameter, are treated as the same point.

Motor Parameter Window:
-

Enables entering a user-defined "Min. Rotation Step " in window “Motor
Parameters”.

FEMAG Process Detection:
-

Enters the monitoring period for a running FEMAG process. If during this time
no CPU time is consumed by FEMAG, it is assumed that the calculations
performed by FEMAG are either completed and result files are saved or a
FEMAG error has occurred and no results are available. In this case, the
cause of the error must be clariyfied and the calculation restarted.

Generate Complete Motor Model
-

With this is it possible to display in smartFEM main graphic window the
complete motor model and rotate it.

Show FEMAG Calculation Window
-

With this is it possible to display or hide the FEMAG
windows during all FEM calculations. The FEMAG
windows can also be switched on and off for single
FEM calculations by right mouse click on the
related button.

-

In FEMAG release 9.7.34.10 windows are generally hidden.
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2.3.1.4

GUI: setting for the graphical user interface

Fig. 13: Tools - smartFEM Settings - GUI settings

Topology Window:
Selection of the action for the "Return” key:
-

“Apply Changes and Exit“
Apply all changes and exit the topology

-

“Apply Single Parameter Only“
Apply the parameter value of the actually selected parameter field whereby
the cursor remains in this parameter field.

Flux Lines Colors:
-

Definition of the colors of Flux lines used in “Plots”. Default color is black.

Winding Coils Icon:
-

User defined color and size of icons and text in the graphic window of
“Windings”.

Drawing Parameters:
-

User defined thickness of “Open Geometry”, “Intersecting Geometry” and
“Dimension” lines and arcs.
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2.3.2

Project

Via "Project Settings", project information such as project number, project name, etc. can be added to
a perspective motor design. They are displayed among other things in the project report generated by
smartFEM.
Fig. 14: Tools - Project Settings

2.3.3

Material Legend

Through "Material Legend Settings" the colors and
designations can be set for surfaces used in the current
motor design for each project separately.

Fig. 15: Tools - Material Legend Settings
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3 Developing with smartFEM
3.1

Motor Geometry

After starting smartFEM and
selecting the menu "File → New",
you can select a motor type. Only
those types of motors are displayed
for which rotor and stator topologies
are stored in the topology list.

Fig. 16: Creating a new motor type

After pressing the "Apply" button, a new motor model is created based on the preset parameters for
rotor and stator geometry, and the motor geometry is displayed for a BEMF period in a graph.

Fig. 17: Motor Geometry
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Depending on the selection in the lower area of the geometry window, further geometry views are
displayed together with according information contents, like for example:
Fig. 18: FEM model with minimal geometrical
symmetry of rotor and stator

Fig. 19: FEM model zoomed

In all the views, after clicking the left
mouse button to a certain position,
the scroll wheel can be used to zoom
in any content as far as possible.

Fig. 20: Measurement of distances

After selecting the button "Measure
Distance Between Points", distance
measurements between two mouseclicked positions can be performed.
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3.1.1

Developing steps

Developing the simulation model up to the first simulation or calculation is best done through the
following steps:
•

Defining rotor geometry

•

Defining stator geometry
In case of external or internal rotor motors, the internal or external diameter of the stator is
automatically adjusted to the external or internal diameter of the rotor.

•

Selecting materials

•

Input of winding scheme and winding parameters.

•

On the base of the selected coil/slot combination of rotor and stator,
a winding scheme with maximum BEMF is automatically suggested.

•

Defining motor and calculation parameters
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3.1.2

Rotor

After selecting the "Rotor" button, the geometry of the rotor topology is drawn in the graphics window
and the corresponding parameters are displayed in a pop-up window in three groups "Geometry",
"Basic" and "Elements".
By opening the selection field "Types of Rotor", all rotor topologies saved in the smartFEM topology
folder for the corresponding motor type are displayed.

Fig. 21: Selecting a rotor topology

After selection of a topology the geometry parameters are displayed immediately in the graphical window
and its associated alphanumerical parameter in the before mentioned three groups (tabs):
- “Geometry”

these parameter define the geometry based on Cartesian or Polar
Coordinates of points which are connected by arcs, lines and/or
curves.

- “Basic”

these parameter describe general values assigned to the geometry

- “Elements”

these parameter display properties of arcs, lines, curves, areas and
points. Different parameter can be edited, i.e. to parametrize node
chains.

The geometry can be displayed in the graphical window as:
- drawing of arcs, lines and curves
- colored areas showing the material
- node chains
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3.1.2.1

„Geometry“ Parameter

The parameters describing geometry are displayed in the parameter group "Geometry". As soon as the
cursor is positioned into a parameter field using the mouse or "Tab"-key, parameter specific dimension
arrows are displayed as help information in the graphic.

Fig. 22: Rotor - Geometry parameter

Each input of a new value (e.g., Width of Magnet) results in re-calculation of the geometry, which is
redrawn directly in the graphic window. Parameter fields with green font contain calculated parameters,
which are used for information and cannot be changed.

Fig. 23: Rotor - Display of modified geometry

Parameters, which have been changed after selecting the topology, are only accepted and saved after
pressing the "Apply" button. If you leave the parameter window via the "Exit" button, no changes are
accepted and the origin geometry is displayed again.
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The “Un-Do” and “Re-Do” buttons allow user to refuse
actual input i.e. in case of faulty input and display the
previous value.

Fig. 24: Rotor - Un-Do and Re-Do

3.1.2.2

„EditGeometry“ – User Defined Geometries

Beginning with smartFEM release 2.11 is possible to edit user defined geometries .

Fig. 25: Edit Geometry - User defined Elements

Details are described in the document „Topologies 2.11.00 de.pdf“ which can also be opened by
menu „Help – About“.
3.1.2.3

Plausibility Checks

In order to develop geometry, the user can enter parameter values in any order. Due to their dependence
on other values, they initially might not appear plausible because they are outside of the currently
permissible value range. The Geometry is therefore only consistent when all parameters are entered
with correct values.
Immediately after the input of one value, all values are subjected to a consistency check. Depending on
the type, the identified incompatibilities are treated as follows:
•

If a value is entered which is too small or too large, it can be automatically reset to the
permissible minimum or maximum value. I.e. the magnet cannot be wider than the
sector of the rotor. The input value of the number of magnets has a higher priority.

•

The lines and surfaces affected by the entered value with the resulting overlaps are
displayed in the graphic in red color, the "Apply" button is renamed to "Bad Geometry"
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and is also changed into red color. The user has now to correct the last input value or
change other values so that the geometry no longer has any inconsistencies.

Fig. 26: Rotor - Plausibility checks

•

3.1.2.4

Open lines and arcs are displayed in blue color. It is not a problem if these are positioned
on the sector lines to the air gap. These lines are in dependence of the rotor type
necessary to connect the rotor geometry to the air gap layer. If further open lines or
circular arcs exist after a DXF import of a rotor or stator geometry, this must be checked
and corrected in the CAD drawing (see also DFX import). The line thickness can be set
in "smartFEM Settings - GUI".

„Basic“ Parameter

In the parameter group "Basic", the so-called basic parameters can be edited:

Fig. 27: Basic parameter
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• Basic node angle

Minimum node distance at the air gap in deg. A precise
definition and explanation is given in 3.1.2.5

• Decimal Places

The number of decimal places displayed.
All parameters are rounded according to the input or before
output.

• Scaling Factor

A scale for enlargement or reduction exclusively for rotor
geometry. All input parameters are multiplied by this factor.
Exception: Internal or external radius of the stator in the
case of internal or external rotors. They are calculated from
the outside or/and inside radius of the rotor + air gap. In this
case, the stator parameters are stretched in the radial
direction.

• Node chain connection to air gap This is used to control the connection of the geometry to the
air gap.
• Priority

This is used to control whether the input value "Node
Distance Factor" or "Number of Segments" on the node
chains is kept constant when geometry parameter are
changed.
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3.1.2.5

„Elements“ Parameter - Node Chains

The base for the required mesh for the FEM calculations are the node chains represented from the
drawing elements: "line", "circular arc" and "curve section". The node chains are built from every drawing
element by segmented lines whereby nodes indicate begin and end of each segment.

Fig. 28: Node chains with indication of the base node angle

The number of the segments is calculated by:
• Rotating motors:
Number of Segments = Integer (

 

 ×     

)

Bna = Base node angle [°mech] respectively [deg]
= angle between 2 nodes at the air gap arc with center point P(x,y) = (0,0)
element length in rad]
Node distance factor = element-specific factor (editable in parameter group "Elements")
• Linear motors:
Number of Segments = Integer (

 

 ×     

)

Bnd = Base node distance [mm]
= distance between 2 nodes at the airgap line
Node distance factor = element-specific factor (editable in parameter group "Elements")
Base node angle and element-dependent factors are pre-set for each topology with values that provide
a “good” network for the FEM calculations
The user can adjust the base node angle respectively base node distance in the parameter group
"Basic". It applies to all drawing elements. The element related factors are adjusted individually in the
group "Elements" for each drawing element.
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The setting of the node spacing in the central air gap layer, which
is important for an accurate power calculation, can be carried out
in the dialogue field "Motor Parameters" with the parameter "Min.
Rotation Step" (see also 3.6). It should be chosen in such a way,
that the network elements get the shape of a square as much as
possible.

Fig. 29: Node chains in the air gap

3.1.2.6

Adjustment of node chains

By clicking the right mouse button on
a drawing element (point, line, arc),
the element is highlighted with
additional information.

Fig. 30: Rotor geometry - Representation of node chains

Simultaneously, the parameter
window changes to the group
"Elements", the cursor is positioned
in the relevant parameter field and
additional information is displayed.
An element can also be selected by
entering the element number.
The distance between nodes can be
entered in the parameter field "Node
distance factor" as a multiple of the
base node distance for the selected
element. Subsequently, the number
of segments is calculated. When
entering the "Number of Segments"
the "Node distance factor" will be recalculated according to this number.
Fig. 31: Rotor geometry - "Elements" group

If the length of the element is changed, the "Node distance factor" or "Number of segments" is kept
constant, depending on the setting of the parameter "Priority" in the "Basic" parameter group.
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When creating lines, non-linear node spacing can be generated with the help of an additional factor
-1 ≤ „Nonlinear node distance factor“ ≤ 1 in order to adjust distances between nodes at the beginning
and end of a line to the adjacent elements. By changing the sign, the direction of the node spacing is
reversed.

Fig. 32: Rotor geometry - Non-linear node chains
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3.1.3

Stator

The stator geometry is, just as the rotor geometry, selected and processed accordingly. Here are also
several stator typologies available, which the user can select.
When selecting "One Coil Per Slot" or "Two Coils Per Slot", either "one-layered" or "two-layered
fractional slot winding" will be set as a winding type. In some stator typologies, for "two-layered fractional
slot windings", it is possible to select lower/upper layer with equal surface areas, in addition to the
position in the left/right slot half.
The editing of node chains is analogous to the rotor.

Fig. 33: Stator - Edit
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3.1.4

Saving, DXF and FEMAG export

After editing the rotor and stator geometry, the entire model can be saved and the geometry will be
exported in FEMAG- and DXF file formats.

Fig. 34: Saving and exporting a motor geometry

All drawing elements of a topology can be exported into a DXF-File based on the format specification of
“AutoCAD® dxf-reference”:
-

Rotor
Stator
Periodic Model
FEM Model

Additionally can be selected whether only “Material” or “Steel Material” contours should be exported.
In the menu of all topologies can DXF files be created with all the text information regarding the
properties of drawing elements, i.e. Basic Parameters and Element Information.

Fig. 35: Saving and exporting a motor geometry

Further details are described in chapter "7.3 DFX Export”.
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3.2

Materials

By clicking the left mouse button on the "Material" button, a pop-up window is opened for the entering
of material data for electrical sheets, magnets and coils.

Fig. 36: Material Settings - Assignment of material properties

The “Relative Length” of material refers to the length of the motor, which can be edited in “Motor
Parameters”. It is used together with the material densities for the calculation of masses and moments
of inertia and are also taken into account for calculation of BEMF, torque, etc.

3.2.1

Stator Coil

Fig. 37: Material Settings - Stator coil parameter

The parameter values of “Conductivity”; “Mass Density” and “Relative Length” can be edited. Default
values are provided for copper material. “Mass” and “Area” of this material of the complete machine are
calculated values based on the mass density and related coil of area the stator including head windings.
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3.2.2

Stator and Rotor Steel

Fig. 38: Material Settings - Stator steel parameter

User can select material type “Linear” or “Non-Linear” and in case of
-

“Linear”
values for “µr”, “Mass Density” and “Relative Length” can be edited.

-

“Non-Linear”
A material file containing properties i.e. BH curves, loss data, mass density, etc. can be selected
from a drop-down list. Only the “Relative Length” can be edited.

Fig. 39: Material Settings - "Non-Linear" steel parameter

36

smartFEM

For assignment of different materials in stator and rotor topologies for individual areas can
different material numbers "MatNo" be assigned in parameter group “Elements” which then are
displayed in toned down colors. This has to be done first before the material data can be
assinged accordingly to "MatNo" in “Material Settungs” for stator and rotor steel.

Fig. 40: Material Settings - Assignment of different material numbers “MatNo” for different areas within one topology

Creation and maintenance of the material files with BH-Curves and loss data/coefficients can be done
with the “Material Explorer” software (see 3.2.4 Material Explorer / Material Editor).
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3.2.3

Magnets

For description of the magnet properties in case of “Linear” calculation remanence induction “Br”, relative
permeability “µr”, “Conductivity” and “Magnetization” of the magnetic material have to be specified.

Fig. 41: Material Settings - Magnets

In case of “Non-Linear” calculation can the demagnetization characteristic curves and loss coefficients
also be defined with the “Material Explorer” and selected in „Material“.
The magnetization direction can be set on "Parallel", "Radial", "Halbach" and "User Defined" whereby
the direction of magnetization is displayed in the graphical window.

Fig. 42: Material Settings - Magnetisation
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For “Parallel” magnetization an offset angle for rotation of the magnetization direction can additionally
be specified.
In
case
of
“Radial”
the
magnetization can be additionally
edited in a text table, displayed in
a graphical window and saved as
text file *.dat in the material folder.
The
magnetization
is
automatically adjusted to the
respectively selected magnetic
width (W m = 180 °el).

Fig. 43: Material Settings - Magnetization table

In "User Defined"
magnetization,
for
each
individual
magnet, all parameter
shown in the text table
can be edited and set
as "Default".

Fig. 44: Material Settings - User defined magnetisation

There is also a possibility of importing measured magnetization of ring magnets and converting it for the
use in smartFEM and FEMAG.

Fig. 45: Material Settings - Measured magnetization
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Additional parameters have to be entered in the menu "Measure Options" to complete the measurement
data.

Fig. 46: Material Settings - Additional parameters for measured magnetization
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3.2.4

Material Explorer / Material Editor

The material properties of electrical steel and permanent magnets can be edited and viewed with the
smartFEM “Material Explorer“. It includes an interface to convert the material data into formatted files
which can be used for FEM calculations with FEMAG, JMAG, MAXWELL, SPEED and into formatted
text files for individual use in other software tools.
The Material Explorer was developed in collaboration with thyssenkrupp Steel Europe AG (TKSE) in
Bochum, Germany. TKSE provides the software named as “PowerCore® Explorer” independently from
smartFEM.
The functionality of Material Explorer is described in the document "User Guide Material Explorer".
3.2.4.1

Electrical Steel

With installation of smartFEM, the data of three TKSE standard materials for non-linear calculations are
copied into the smartFEM material folder. Further material data of TKSE product range can be received
directly from TKSE in Bochum.

Fig. 47: Material Explorer - B(H) and loss data of electrical steel
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3.2.4.2

Permanent Magnets

In addition to electrical steel, with the help of Material Explorer also non-linear "demagnetization
characteristics curves" of permanent magnets can be recorded and can be stored as FEMAG specific
mc-, mca- and txt-files. For this purpose, the material type “Permanent Magnet” must be selected when
storing the files.

Fig. 48: Material Explorer - Demagnetization characteristics of magnet material

At present, the demagnetization characteristics curves of a material for different temperatures have to
be individually recorded and stored.
Loss coefficients and loss data are currently not used by smartFEM. To calculate the eddy current
losses in the magnets, the conductivity entered in "Materials" is used.
The creations of the characteristics for non-magnetized magnetic material are analogous to the
characteristics for electrical steel. This data is used in the simulation of magnetization processes with
the smartFEM module „PM - Magnetization - Inner Rotor“.
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3.3

Preprocessing

A prerequisite for the calculation of results and their analysis by FEM simulation is the structure of the
FEM model in FEMAG. After pressing the "Preprocessing" button, FEMAG is started, all necessary
information about geometry, node chains and materials is transferred to FEMAG, and the FEMAG
process from smartFEM to the field calculation is controlled by the FEMAG menu sequence "Field
Calculation" → "Calculate Once".

Fig. 49: Preprocessing - Structure of the FEM model with FEMAG

After successful "Preprocessing", the button "Calculation" will be displayed. The user can now carry
out a first FEM simulation with determination of the cogging torque (if applicable at this time) (see
3.6.1 Cogging Torque and BEMF).
The "Preprocessing" can be controlled with right-click on the "Preprocessing" button as follows:
- Show / Hide FEMAG

Show / Hide FEMAG windows.

- Stop FEMAG on Error

FEMAG is paused after an error, so that the user can determine
the cause of the error.

- Only Meshing

Only meshing is performed.

- Preprocessing + Calculation

After "Preprocessing", the calculation type selected in Motor
Parameters is automatically executed.

Fig. 50: Preprocessing - Show FEMAG
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After "Meshing" has been successfully completed, the network representation can be opened via the
"Plots" button.

Fig. 51: Preprocessing - Meshing and node chains

After optimizing the mesh, "Preprocessing" can be completed by further pressing the "Preprocessing"
button.
As soon as a change to motor geometry or material is made at any later time then the text "Calculation"
is automatically reset to "Preprocessing", all results are deleted and the preprocessing must be run
again.
For the calculation of further results e.g. BEMF, Torque, etc., the motor model has to be completed
together with information on windings and further motor parameters (see 3.4 Plots and 3.6 Motor
Parameters).
Furthermore, the skilled user can edit or evaluate the generated FEMAG model directly with FEMAG
(see 7.1 FEMAG).
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3.4
3.4.1

Field Plots
Definition and display of field plots

After successful "Preprocessing", the design of the magnetic circuit can be assessed using "Plots". To
do this, in the "Field Plots Definition" menu, "Plots - Define Picture" must be opened:

Fig. 52: Field Plots - Field Plots Definition

After opening the plot window (it is possible that FEMAG field calculations are performed beforehand),
the various plots can be selected and displayed:

Fig. 53: Field Plots - Magnetic induction with
superimposed flux lines

Fig. 54: Field Plots - Demagnetization

Flux lines, scaling and other parameters can be adjusted by clicking the right mouse button on the
selection field.
The plots can be viewed on the screen as well as on the project report. All plots can be overlaid. The
overlay is undone by a further click on the corresponding button. The number of flux lines as well as the
minimum or maximum values of the result calculations can be adjusted by clicking the corresponding
button with the right mouse button.
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Furthermore, details can be viewed at any depth using the already mentioned zoom function. In
addition, the x/y coordinates of the mouse pointer and other information are displayed in the status
line.
The user can select from the following plots:
• Geometry
Points
Lines
Areas
• FEM-base
Node
Node chains
Networking
Materials
• Magnetic circuit results
Vector potential
Current densities
Flux lines
Magnetic flux density
Demagnetization
Relative permeability
Remanence
Magnetic polarization
A bigger number of sets can be created easily by using the “Parametic” function.

Fig. 55: Field Plots - Table for parametric definition of sets
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3.4.2

Model Data

For user-defined evaluation, the properties of nodes and network elements can be exported via the
clipboard:

Fig. 56: Field Plots - Export Model Data

Fig. 57: Field Plots - Exported model data example

Through "Calculate", the torque, radial force and the angle of the force vector in the air gap can be
calculated. At the same time, the data is made available in the buffer memory.

Fig. 58: Field Plots - Force in Air gap
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3.4.3

Creation of Filed Plots with the same layout

In the "Field Plots Definition" table several images can be defined for different rotor positions and
currents. They can be defined individually with "Define" → "Picture” using different contents. Currents
can be entered manually or transferred from the results of "Expected values", "Nominal Torque" or
"Dynamic” for the selected table lines through the "Data" → "Paste Currents" dialogue ".

Fig. 59: Field Plots - Definition of sets

The images can also be created
with "Solve All". In this case all the
images show the same section.
However, to achieve this, the
settings of an image must be saved
beforehand via "Options" → "Save
Settings" as well as the image itself
with "Define Picture".

Fig. 60: Field Plots - Saving settings after
crating the image content
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If then an image with "Show Picture" is opened and the arrow keys are used to move up or down in
the "Field Plots Definition" table, all images are displayed successively, so that the field changes can
be observed very well. By clicking on a column header, the table is sorted up or down according to the
column values.

Fig. 61: Field Plots - Display of the plots per set

Flux lines can be displayed in different
colors (black/white is default). By clicking
the right mouse button on the "Flux Lines"
button, a corresponding pop-up window
opens.

Fig. 62: Field Plots - Colored flux lines
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In the smartFEM settings, the colors for the
direction of the flux lines can be adjusted
clockwise and counterclockwise.

Fig. 63: Field Plots - Colored flux lines

The table „Field Plots Definition“ can be copied into
the clipboard containing all calculation results.

Fig. 64: Field Plots - Copy Results

Fig. 65: Field Plots - Table containing calculation results
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3.5

Windings

For the description of windings, there is a winding editor available at smartFEM. If there is at least one
permissible winding scheme for the motor geometry described up to this point, the button "Winding
Defined" is displayed and the winding scheme is set as default. Otherwise the text "Winding Not Defined"
is displayed in the button. N-phase winding patterns can be described as single/two-layered with
integral/fractional windings and parallel winding groups/phase.

Fig. 66: Winding Editor - Opening the smartFEM button "Winding ..."

The number of slots (S ..) and individual coils (C ..) together with current direction (in/out) are displayed
in the winding surfaces.
The color and the size of the text and
icons can be set in "smartFEM
Settings - GUI".

Fig. 67: Winding Editor - The color and the
size of the text/icons in smartFEM Settings
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3.5.1

Coils Parameters

Through "Winding Definition" → "Coils
Parameters" a pop-up window will be opened
in Which input fields the wire diameter, number
of turns per coil and an additive phase
resistance/induction can be entered.
For a conductor type, "round" or "rectangular"
can be selected.
In addition, the slot area available for the
winding per slot and the fill factor are
displayed. The fill factor is calculated as
follows:
Fill Factor = Number Of Turns per coil *
Conductor Area / Slot Area

Fig. 68: Winding Editor - Coils parameters

With “Options” another menu is displayed. It
provides functions for specifying the number of
turns, calculating the number of turns at a
predetermined filling factor and calculating the
conductor cross section with predetermined
values for fill factor and number of turns
available.
Fig. 69: Winding Editor - Coils parameters - Options
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3.5.2

Winding Scheme

Through "Winding Definition" → "Winding Scheme", the winding scheme can be processed in a list. As
additional support, the entire motor is displayed as a graph. As soon as there is a permissible winding
scheme, it is displayed as "Auto Winding“. The slots corresponding to the phases are colored. The slot
area in which the cursor is located is shown in yellow. With the help of "Auto Winding" the winding
scheme is generated,
with the maximum
induced voltage.

Fig. 70: Winding Editor - Winding scheme "two-layer fractional slot winding" The values for
amplitude Flux Vector, Distribution, Pitch and Winding factor are displayed

Fig. 71: "Two-layered fractional slot,

"One-layered winding"

"Ring winding"

„Options":
-

"Default Winding":

The winding scheme with which the window was initially opened,
appears again.

-

"Auto Winding":

The winding scheme with maximum BEMF will be automatically
determined and displayed.

-

"Symmetric Winding": The input for the phase U is automatically assigned into the V and W
phases with an offset of + 120 ° el.

-

"Clear All":

The winding pattern is deleted and can then be redefined by the user.
By clicking in an entry field from the list, are not yet specified windings
shown and can be selected. The corresponding slot surface is then
filled with the color of the respective phase.
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Fig. 72: Winding Editor - User-definition of the winding scheme

A user-defined winding scheme is adopted by clicking the "Apply" button. The entire winding definition
can be saved with "File" → "Save Winding Definition" in a text file *.wdf and later used in other motor
models through "File" → "Open Winding Definition".

Fig. 73: Winding Editor - Saving or loading a winding definition

The winding editor is closed with "Apply Changes", in case that the winding definition should be adopted
for the current motor model. If the current motor design should not be changed, the winding editor has
to be closed via "Cancel".
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3.5.3

Phase Diagram

Through the "Diagrams" menu, the vectors of the phases and coils are displayed. With this is the user
able to check the winding scheme for faults.

Fig. 74: Winding Editor - Phasor Diagram
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3.6

Motor parameters and calculations

Depending on simulations and calculations the user wants to carry out, various motor parameters must
be entered.
All simulations of the motor are related to rotor positions. Starting from the normal 0° position of the rotor
is it rotated counterclockwise by a certain angle after each calculation in order to perform the next
simulation. The number of calculation steps and the calculation accuracy can be specified as a
termination condition by the user.
The calculations are triggered via the "Calculation" button. By clicking with the right mouse button on
the "Calculation" button, various settings can be made in accordance to the "Preprocessing" button.
3.6.1

Base for the results calculations

The base for the results calculation is the single-phase equivalent circuit diagram of a synchronous
motor.
The in “Results” displayed "Torque With Applied Current" represents the "inner" torque because iron,
magnet and other losses which lead to a reduction of the torque on the shaft is not taken into account
during FEM calculations. These losses can be calculated as a torque loss for the given speed with the
help of the formula P = T * ω and will be considered in "Torque After Losses“.

Fig. 75: Equivalent circuit diagram for synchronous motor

In "Results" an overview of the various result parameter (i.e. losses, internal /external torque, active
power, apparent power, power factor, cosφ, efficiency, etc.) is displayed under the tab "Overview".
Losses are only taken into account if they have been previously calculated.

Fig. 76: Results parameter as "Overview" table
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3.6.2

Cogging Torque and BEMF

Fig. 77: Motor parameter - Cogging torque + BEMF

Model Parameters Info
-

Minimum Rotation Step x ° mech
Minimum angle of rotation of the rotor step in ° mech. This also corresponds to the node angle
in mid air gap layer between rotor and stator. Through the selection box also different values
can be selected. The adjustment should be set so, that the net elements in the central air gap
layer become as quadratic as possible to ensure high accuracy of the power or torque
calculations. When "smartFEM Settings - General" is set to manual entry of "Min. Rotation
Steps ", any user-defined step width can be specified.

-

Cogging torque Period x ° mech
Cogging period in ° mech.

-

BEMF Period x ° mech
Period of the induced voltage in ° mech.

-

Maximum Number Of Steps x
Maximum number of calculation steps per period. 2 periods are calculated.

Calculation parameter
-

"Movement Type"
User can choose between the calculation for the entire period or a part of the period. When
choosing a partial period, only cogging torque and flux are calculated.

-

"Permeability Mode"
With the help of this tab, the calculations in FEMAG are controlled. When "Restored" is
selected, the calculations are started at each step angle with "zero". When "Actual" is selected,
it starts with the result of the previous step angle. This has an influence on the number of
iterations and, if necessary, also on the accuracy of the calculation results. This needs to be
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evaluated and selected individually by the user. "Restored" ends in very good results, but it
sometimes requires significantly more iterations and thus calculation time.
-

"Number of Calculation Steps per period"
The calculation of Cogging Torque + BEMF is carried out through two cogging torque periods.
The specification of the minimum rotor rotational angle is dependent on the period length, in
order to keep the calculation time within acceptable range that is justifiable to the accuracy of
the curve.

-

"Convergation Accuracy"
Termination condition for the calculation accuracy of the permeability changes in FEMAG.

-

"Motor Length"
Motor length without projection.

-

"Skewing"
Herewith the effects of optimization are calculated by skewing of the rotor or stator. Total angle
of inclination and the number of skew steps are indicated.
Skew Angle
0 = no inclination
n = inclination in °mech over the entire motor length
Number Of Skew Steps

0 = no inclination
1 = continuous inclination on the specified angle
n = number of laminated cores
the first laminated core is always in the position of 0 ° mech!

Example:
Skew Angle = 15 °mech
Number Of Steps = 4 Skew
Angular offset of the laminated cores to each other =
15 °mech / (4-1) = 5 °mech
-

“Operational speed”
Rated speed of the motor in revolutions per minute.

-

“Winding Connection”
Winding circuit "star" or "triangle".
With "Reset Results" previous calculated results are deleted, with "Apply" the entered data is
accepted and the window is closed, with "Exit" the window is closed without saving the data.
If the preprocessing has already been performed, then the calculation can be started by
pressing the "Calculation" button.

„Apply, Exit, Reset Results“
With “Reset Results” previous calculated results are deleted, with "Apply" the entered data will be
accepted and the window will be closed, with "Exit", the window is closed without changing any data
which were entered before.

Fig. 78: "Apply, Exit" Motor Parameters
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After “Preprocessing” has been performed before can now the calculations be started by pressing the
button “Calculation”. The calculation results are shown in a graphic form. Both graphics and numerical
result values can be copied to other applications via the clipboard.

Fig. 79: Results - Results Cogging Torque

Overview of all the results of a "Cogging Torque + BEMF Calculation" in the form of graphs:

As smartFEM determines and stores the flux for each slot and rotor position, the results are determined
without further FEM calculation if the winding scheme, motor length, skew angle, skew steps and speed
are changed. This is displayed immediately after entering the changed parameters.

Fig. 80: Example of influencing the BEMF by inclination
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3.6.3

Expected Values

In order to make a rapid prediction of the expected torque, the torque is determined based on the
previously calculated BEMF using FEM and analytically calculated and displayed as "Expected Value".

Fig. 81: Results - Expected Values

The calculation is performed according to the selection of constant phase current, sinusoidal phase
current and trapezoidal or user-specific phase current. The selection can be seen in the menu „Nominal
Torque + Inductance Calculation“ „Coil Excitation - Current Parameters“. Since no additional FEM
calculation is necessary, the results are displayed immediately.
Overview of all the results of a "Cogging Torque + BEMF Calculation" in the form of a graph and
displayed as "Expected Values":
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3.6.4

Nominal Torque + Inductance

The calculation of the nominal torque is carried out in such a way that in each rotor position, the torque
is calculated in de-energized and energized state using FEM. Subsequently, the nominal torque is
calculated by difference formation. The adjustment of calculation parameters can be performed in "Motor
Parameters".

Fig. 82: Motor Parameters - Nominal Torque + Inductance

Model Parameters Info
-

Minimum Rotation Step x ° mech
Minimum angle of rotation of the rotor step in ° mech. (according to 3.6.2Cogging Torque and
BEMF)

-

Cogging Torque Period x ° mech
Cogging period in ° mech.

-

BEMF Period x ° mech
Period of the induced voltage in ° mech.

-

Maximum Number Of Steps x
Maximum number of calculation steps.
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Phase Shifts - from Cogging Torque + BEMF Calculation
Phase Shifts - from Nominal Torque + Inductance Calculation
-

By execution of "Cogging Torque + BEMF Calculation" the phase angles between the individual
windings are determined, which is then displayed in "Nominal Torque + Inductance Calculation".

-

If „Nominal „Torque + Inductance Calculation“ is
selected, the phase angles are displayed if previously
„Cogging Torque + BEMF Calculation“ was performed.

-

If no „Cogging Torque + BEMF Calculation“ was carried
out, „Phase Shifts: Not Defined“ is displayed.
If the check sign is set on "Calculate Phase Shifts“, the
phase positions are automatically recalculated before
the nominal torque calculation.
For this purpose a torque calculation is performed with constant current for each phase. The
angles (° el) of the maxima of the torques correspond to the positions of the respective phase.
Then the actual "Nominal Torque + Inductance" calculation is carried out.

-

„Phase U/V/W: not defined“ is displayed for the motor types „Switched Reluctance“ and
„Universal Motor“. Since these types of motors do not include magnets, it is not possible to
calculate BEMF and the phases of the windings. These are then determined before performing
the actual torque calculation as previously described. (See also 6.3 Switched Reluctance Motor)

Calculation Parameters
-

"Movement Type"
User can choose between the calculation for the entire period or a part of the period.

-

"Permeability Mode"
This is used to control the calculations in FEMAG. When "Restored" is selected, the calculations
are started at each step angle with "zero". When "Actual" is selected, it starts with the result of
the previous step angle. This has an influence on the number of iterations and, if necessary, also
on the accuracy of the calculation results. This needs to be evaluated and selected individually
by the user. "Restored" ends in very good results, but it sometimes requires significantly more
iterations and thus calculation time.

-

"Number of Calculation Steps per period"
The calculation of Cogging Torque + BEMF is carried out through two cogging torque periods.
The specification of the minimum rotor rotational angle is dependent on the period length, in order
to keep the calculation time within acceptable range that is justifiable to the accuracy of the curve.

-

"Convergation Accuracy"
Termination condition for the calculation accuracy of the permeability changes in FEMAG.

-

"Motor Length"
Motor length without overhangs.

-

"Skewing"
Herewith the effects of optimization are calculated by skewing of rotor or stator. Total angle of
inclination and the number of skew steps are indicated.
Skew Angle

0 = no inclination
n = inclination in ° mech over the entire motor length

Number Of Skew Steps

0 = no inclination
1 = continuous inclination on the specified angle
n = number of laminated cores,
the first laminated core is always in the position of 0 ° mech!
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Example:
Skew Angle = 15 °mech
Number Of Steps = 4 Skew
Angular offset of the laminated cores to each other = 15 °mech / (4-1) = 5 °mech
Note: In the current smartFEM version, the nominal torque calculation and the loss
calculation are only carried out for Skew Angle = 0 °!
-

“Operational speed”
Rated speed of the motor in revolutions per minute.

-

“Winding Connection”
Winding circuit "Star" or "Delta"

Stator Coil Excitation - Current Parameters
Different current waveforms can be entered:
-

Constant current with amplitude indication

Fig. 83: Coil Examination - Constant Line Current

If the "Calculate Phase Shifts" button is pressed, the positions of all phases are determined before the
actual nominal torque calculation.
-

Sinusoidal current with amplitude indication and phase shift between current and BEMF per line

Fig. 84: Coil Examination - Sinus Shape Line Current

-

Id-Iq with indication of the currents in the d- and q-axis:

Fig. 85: Coil Excitation - Id-Iq Effective Phase Current
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-

trapezoidal curve shape of the phase currents with amplitude indication, phase shift and
function width. The function width is the range in which the amplitude is 100%. Flanks with a
linear ascent and descent are shown in between:

Fig. 86: Coil Excitation - Trapezoid Shape Phase Current

Fig. 87: Coil Excitation - Trapezoid Shape Line Current

-

“Lead Phase”
In case that non-symmetrical phase currents or phase positions of the BEMF result from
geometry and/or winding scheme (which have a phase shift unequal to 360°/total number of
phases), a single phase can be set as leading. The currents of other phases are then
automatically defined in such a way that an equal phase shift occurs between all the currents.
This is necessary to simulate the behavior of conventional controls that cannot produce
unsymmetrical phase shifts.
In case where no leading phase is selected, the phase shifts between the phase currents are
defined when their result from the unsymmetrical BEMF.
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-

user-specific curve shapes of the phase currents:

Fig. 88: Coil Excitation - User Defined Phase Current

The corresponding settings can be made via the "Edit Shape" button. A table with a sinusoidal
current profile is created as default.

Fig. 89: Coil Excitation - Phase Vector Currents Input Table

The user can directly modify the values contained in the table, make settings via "Options" or
copy and paste a table of values created in another tool.

Fig. 90: Phase Vector Currents Input Table - Current Options
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With "Current Options" the following settings are possible:
"Initial Values":

Save or load the saved value table.

"FFT Sampling":

Sampling rate for Fourier decomposition, default = 1000

"Align with BEMF":

Adjustment of the phase positions of the current waveforms
according to the BEMF per phase

"Symmetric Current":

Current values input in phase U are copied to the other
phases with a phase shift of 120 ° and 240 °.

"Phase Shift":

A phase shift can be entered individually for all or each phase.

"Global Amplitude Change":

The amplitudes are multiplied by the entered factor.

„Apply, Exit, Reset Results“
With “Reset Results” previous calculated results are deleted, with "Apply" the entered data will be
accepted and the window will be closed, with "Exit", the window is closed without changing any data
which were entered before.

Fig. 91: "Apply, Exit" Motor Parameters
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3.6.5

Calculation

If the "Preprocessing" has already been carried out the calculations can now be started by pressing the
button „Calculation“. After calculations are finished, can the results be presented in different graphs.

Fig. 92: Display of results for nominal torque with sinusoidal current

Overview of all the results that can be presented as a graph after performing "Nominal Torque +
Inductance Calculation":

Fig. 93: Overview Calculation Results

If afterwards skewing parameters or motor length are changed, all forces and torques are also
recalculated without the need for new FEM calculations.
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1.1.1

Dynamic calculations

Dynamic calculations can be carried out for motor start-up and steady-state operation. The calculations
are carried out analytically in the time step method on the basis of equivalent circuit diagrams, whereby
the inductances can also be determined in co-simulation with FEMAG.

.
Fig. 94: Motor parameters for dynamic calculation of stationary operating conditions
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“Run Modes”
-

„Steady State“ for steady state operation
"Start Up" for the motor start.

“Phase Parameters Info”
-

Resistors RU, RV, RW and inductors LV, LU, LW of all windings which belong to a phase
Induced terminal voltage
Moment of inertia of the rotor

“System Info”
-

Line to Line BEMF (for Nominal Speed)
Estimated Jr

“Calculation Parameters”
-

"Motor Length"
Motor length without overhangs

-

"Skewing"
Herewith the effects of optimization are calculated by skewing of rotor or stator. Total angle of
inclination and the number of skew steps are indicated.
“Skew Angle”

0 = no inclination
n = inclination in ° mech over the entire motor length

“Number Of Skew Steps”

0 = no inclination
1 = continuous inclination on the specified angle
n = number of laminated cores,
the first laminated core is always in the position of 0 ° mech!
Example:
Skew Angle = 15 °mech
Number Of Steps = 4
Angular offset of the laminated cores to each other =
15 °mech / (4-1) = 5 °mech

-

"Winding Connection"
Winding circuit "Star" or "Delta"

“Dynamics Parameters”
-

"Input Voltage"
Maximum value of an applied constant phase voltage

-

Use Phase Voltage
Instead of the constant phase voltage, through "Input Voltage", user-specific phase voltages
can also be used. In this case, the phase characteristics, the amplitude and the phase angle
can be set as needed. This function can currently only be used in "Run Mode" and "Steady
State".
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Fig. 95: Use of user-specific phase voltages

With "Voltage Options" can user perform various functions to adjust voltages:

Fig. 96: Voltage Options

-

"Initial Values":

Save, Restore

-

"FFT sampling":

Input of a value, Default = 1.000

-

"Align with BEMF":

Set to the same phase angle as BEMF

-

"Symmetric Voltage":

Setting the phases V and W as U with offset of 120 °el

-

"Phase Shift":

Input of a phase angle for all phases equal or different, per
phase

-

"Global Amplitude Change":

Input of a multiplication factor to change the peak value of
the voltage.
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"Electronics" is used to specify the resistances of the transistors and diodes of the inverter in the
equivalent circuit diagram and the time steps of the calculations. Thus, with a good approximation, any
PWM signal can be used for the input voltage of the motor in 3-phase star connection.

Fig. 97: Setting the parameters for the inverter model

-

"Block Commutation"

Input of electrical angle of the commutation duration 120°el
or 180°el.

-

"Control Firing Angle Delay"

Delay angle of commutation time.

-

"Stop Calculation Criteria"

Abort conditions for completing the calculations are linked
with "or" and can be selected and parameterized.

Fig. 98: Termination conditions for dynamic calculations

Phase Parameters
-

"Added Resistance per Phase"

User-specific resistance added as a constant to the phase
resistance.

-

"Added Inductance per Phase"

User-specific inductance added as a constant to the phase
inductance.

-

"Phase Inductances"
"Coupled to FEMAG"
"User Defined"

The inductances are determined for every rotor position by
using co-simulation by FEMAG.
The inductance is calculated from the winding scheme
independently of the rotor position and is specified as a
constant value.
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The calculation results are displayed as graphs. Both graphics and the numerical result values can be
copied to other applications via the buffer (see also 0).

Fig. 99: Dynamic calculation of the torque curve versus rotor position

Overview of all the results that can be displayed as graphs after performing "Dynamic Calculation":
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1.1.2
3.6.5.1

Postprocessing - Forces and Torque
Force Calculation

Basic principles of force vectors:

Note: the force vector must not be
necessarily in the center of the
segment!

F
FT
FN
FNx
FNy

=
=
=
=
=

vector of the total force
tangential component of the force vector
normal (radial) component of the force vector
x-component of the normal force vector
y-component of the normal force vector

Fig. 100: Basic principles of force vectors
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smartFEM allows the calculation in selectable segments of tangential and normal forces that occur in
the middle air gap layer.

Fig. 101: Calculation of Forces

Example of force calculation of motors with a centric and with an eccentric rotor:

Fig. 102: Example of the results of a force calculation
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For parameter input and result output, the window "Force Calculation" can be opened via the menu
"Postprocessing" in the "Motor Parameters" window. The following parameters can be entered:
-

“Arc Starts on”
Beginning of the force calculations area.

-

“Length of Arc”
The length of the arc in which the forces are calculated.
All angles are given in polar coordinates

-

“Number of Segments”
The number of equally long circular arc segments. For each, nominal and tangential force are
calculated.

-

Selection "Cogging Torque" or "Nominal Torque"
Determining which field calculation results are used as a basis for calculating forces. When
selecting "Nominal Torque" indicated forces are considered.

The results are displayed in a table and can be copied through the menu "Options" → "Copy Results"
via the clipboard to other applications.

Fig. 103: Example 1 - Forces calculation in one segment

Fig. 104: Example 2 - Forces calculation in five
segments
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3.6.5.2

Torque

The calculation results of the torque in "Results" are rounded to three significant digits by FEMAG. When
evaluating torque fluctuations, this can sometimes lead to inaccurate results. For this reason, using this
function, the torque is calculated with a higher number of significant digits.
In addition to this, through „Postprocessing - Forces and Torque - Force Calculation“ the force
calculation is given with 1 segment of 0 ° counted over a length of 360 °.

Fig. 105: Postprocessing - Forces and Torque

Subsequently, plots of the torque and its harmonics can be opened and evaluated.

Fig. 106: Postprocessing - Displaying Torque

Fig. 107: Post Processing - Plots of torque and harmonics
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Via "Options - Copy Results", the result data for the torque and air gap induction can be copied e.g. into
a calculation table for specific evaluations.

Fig. 108: Postprocessing - Selecting to copy the result data of the torque
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3.6.6

Post Processing - Loss Calculation

With smartFEM copper losses and iron losses can be calculated in the rotor and the stator. The
necessary measurement and saving of basic data is accompanied by the "Nominal Torque +
Inductance" calculation provided that beforehand the selection "Losses" in "Motor Parameters" was
chosen.

Fig. 109: Motor Parameters - Selection field "Losses"

By selecting the parameter "Losses", all inductions for all network elements for each rotor position are
stored. This results in an increased memory footprint for the motor model to follow. Thanks to this, the
user can then calculate the losses at different speeds and the use of different materials very quickly,
without starting the time consuming "Nominal Torque + Inductance" running calculation.
After performing the calculations for "Nominal Torque + Inductance" the losses can be calculated
through the "Postprocessing" menu.
By default, in addition to this, the material data selected in the "Materials" menu are displayed, which
serve as the basis for all FEM calculations. Other materials can also be selected. However, the loss
calculation using these materials serves only for approximate evaluation because the values of induction
from FEM calculations with the materials selected in "Materials" are used. The same applies to the
conductivity of the magnets in "Magnets Conductivity".
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T
For information, the values of the BH
curve appear when you point the
mouse on the
i sign.

Fig. 110: Loss Calculation - Parameters

Via "Speed - Add Speed Range" further speeds
for the loss calculation can be specified.

Fig. 111: Loss Calculation - Add Speed Range

In addition, the number of magnetic segments in the axial z-direction and a file * .pex with additional
losses (for example, friction, fans, etc.) are indicated.

Fig. 112: Loss Calculation - Magnets Segmentation

Fig. 113: Loss Calculation - Example Textfile.pex
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After pressing the "Calculate Losses" button,
calculations are performed. During this time
"Calculating" button appears.

the
the

A running calculation is aborted by pressing the
"Calculating" button.

Fig. 114: Loss Calculation - Calculation Process

The results of the loss calculation are displayed immediately after the calculation in tabular form and in
plots:
- Iron losses in the rotor
- Iron losses in the stator
- Magnetic losses
- Additional losses
- Copper losses in the windings
- Plots with the loss densities
- Plots with the harmonics of rotor and stator losses

Fig. 115: Results of Loss Calculation
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3.6.6.1

Polynomial Coefficients

For the loss curves, the coefficients (xy and invers yx) of polynomials 3rd to 7th order can be calculated
and copied over the clipboard to create mathematical loss models in other applications.

Fig. 116: Loss Calculation - Polynomial coefficients
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3.7

Ld/Lq identification

For a field-oriented control of permanent magnetically excited synchronous motors, the tables of Ld and
Lq identifications, which are determined by the Park/Clarke transformation, are often used. These tables
can be calculated in smartFEM using the "Ld/Lq" function. The first step is to create a table with fluxes
and their phase shifts. This can be done manually line by line or parametrically via the dialog "Data Add - ..." or parameterized. This table is generated automatically for the simulation of a field-oriented
control with the program "CASPOC" suitable for the simulation of power electronics.

Fig. 117: Ld / Lq - Creation of data records

The records can be calculated individually or all automatically after pressing the "Solve All" button.

Fig. 118: Ld / Lq result table
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Various diagrams can then be output to the result table.

Fig. 119: Ld/Lq - Diagram Torque vs. Theta with is = constant

The phase diagram can be displayed for each selected table line.

Fig. 120: Ld/Lq - Phase diagram

The results table can be transferred and used in other software programs via clipboard by "Options Copy Sets".
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A result table generated for the CASPOC
program is stored in the xml formatted file
via the "Data Caspoc Export File" dialog,
which is used by CASPOC as a look-up
table for electronic simulation.

Fig. 121: Ld / Lq - Creation of a result file for CASPOC
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3.8

Calculation of Special Effects

For the calculation and investigation of specific effects (for example, the resting moment caused by a
single magnet), it is possible to assign different material properties to individual surface elements, like
for example:

Fig. 122: Simulation model with a magnet

Note:
As a result of this, the motor model no longer satisfies
the periodic symmetrical conditions specified by the
number of magnets and slots in the rotor and stator
topology. The results therefore only refer to this
special case and cannot be transferred to the
complete periodic simulation model. User is asked
for acknowledgement in a pop-up-window.

The change in the material properties of individual surface elements is achieved by clicking on the
corresponding surface element with the left mouse button in the representation "Geometry" or "Material"
while simultaneously pressing a key combination "CTRL", "ALT", "Shift":
o
o
o
o

CTRL
ALT
ALT + Shift
ALT + CTRL

→
→
→
→

Rotor Iron
Stator iron
Magnet
Air

Fig. 123: Change of the material properties of individual surface elements

When using this function, it is important to know that when this function is being performed, all results
will reset, and the question pops up whether an "entire" motor model is to be built up.
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3.9

Graphical display and evaluation of results

The results are displayed automatically in a new window in graphics form after a calculation is started
by clicking on the "Calculation" button and performed. If calculations have already been carried out, this
is indicated by the "Results" button in the upper menu line. By clicking on this button, the window with
the graphics is shown.
The individual graphics are selected by clicking on the corresponding line in the menu of the graphics
window on the right side. When a check sign is set in a square, the corresponding graphic is
automatically included in the report when the project report is generated.
The "Options" menu allows you to copy graphics as well as the calculated values via the buffer to other
applications and to edit them there.

Fig. 124: Graphical display and evaluation of the results

3.9.1

Results

The calculation results are displayed as graphics after clicking the "Results" button. Both graphics and
values can be copied to other applications via "Options" → "Copy Picture" or "Copy Data". The
following graphics can be displayed:
3.9.1.1

Cogging Torque and BEMF

• Cogging Torque + BEMF
- Cogging moment and harmonic
- Flow per phase without/with current and harmonic for phase U
- Inductance per phase
- BEMF per phase/string and harmonic for phase U/UV
- ke per strand
• Expected values as an analytical calculation of the expected values for
- Expected motor torque
- Cogging Torque
- Phase current, phase-element current
- BEMF per phase
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3.9.1.2

Nominal Torque and Inductance

The following calculation results can be displayed:
•

Nominal Torque + Inductance
The values are calculated at rotor positions within a BMEF period with the step size specified in
"Motor Parameters".
-

-

3.9.1.3

Torque
Cogging Torque
Reconstructed Cogging Torque
(transformation of the results for the cogging torque at rotor
positions of torque to the rotor positions within the cogging torque
period)
Phase current, line-to-line current
Flux per phase without/with current and harmonics of phase U
Inductance per phase
BEMF per phase/line-to-line and harmonics of phase U/UV
ke, kt per line-to-line
Terminal voltage per phase/ line-to-line and harmonics of phase U/UV
Transformer voltage per phase and harmonics of phase U

Dynamic

The following graphics can be displayed in detail:
•

Dynamic Calculation
- Cogging torque
- Magnetic flux without current
- Phase currents
- Inductors
- BEMF
- Magnetic flux with current
- Number of revolutions
- Strand currents
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3.10 Saving and loading simulation models
Via the menu sequence "File -> Save" and "File Save As" the simulation models can be stored in any
directory. The directory specified in the smartFEM Settings is displayed as the default folder. All
parameter values and results are stored in a "modellname.mot" file. Thus, each simulation model is
consistent in itself. Additionally, the used topology and material files are also stored.
There are several ways to open simulation models:
•

"File -> Open"
The location of the model can be selected and the model opened. The topologies contained in the
topology directory are automatically loaded. If parameter values (dimensions, node densities, etc.)
should not be displayed correctly in newer versions of the topologies, the model can also be opened
with the topologies stored in the model.

Fig. 125: Open a previous saved simulation model

•

With "Ctrl + #" the corresponding simulation model is opened directly. The last four stored model
files and their paths are displayed.
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4 Add-ons
Add-ons are special modules that are created as the dll file type and stored in the “... \ smartFEM \
ElTopology” directory. They are recognized and listed dynamically by smartFEM when the "Add-ons"
menu is selected in "Motor Parameters". Users can also create their own dlls, if they know the interface.

Fig. 126: Add-ons - Call-up menu
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4.1

Motor diagrams

The "MotorDiagrams" module is a special module, with which motor diagrams with different graphics
such as "Torque-speed-diagram" can be generated. The basis for this is an Ld/Lq matrix, whereas the
results of individual Ld/Lq sets in mathematical models with polynomials can be used for creation of
diagrams.
The call up of the module motor diagrams is made in "Motor Parameters" via the "Add-Ons MotorDiagrams" menu.

Fig. 127: Motor diagrams - Call up

The calculations for generating different graphics are performed on the basis of a current-theta matrix
specified by the user.
From the current theta matrix, corresponding sets are generated for the Ld/Lq calculations. In addition
to the Ld/Lq identification, different additional results are calculated for each Ld/Lq set.

Fig. 128: Motor diagrams - Current theta matrix and result values
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In the "Diagram" screen, the parameters for generating the graphs are computed with the calculation of
the graphs to be displayed. The winding connection "star/triangle" is automatically taken over from the
parameter specification in the "Motor Parameters".

Fig. 129: Motor diagrams - Parameters for the calculation of the graphic data

If "0" (zero) is entered, the respective values are taken from the results of the Nominal Torque
Calculation and the Motor Parameters and displayed.
When Input Voltage = DC is selected, the corresponding "Input Voltage Line To Line RMS" is determined
from the input value UsDC and used for the calculations of the motor diagrams:
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Fig. 130: Motor diagrams - Conversion of UsDC <> UsLL_rms
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The parameters for currents and phase shifts from which the Ld/Lq sets are generated for the calculation
of result values of the theta current matrix are entered in the "LdLq Sets" screen window. The "Simple"
type is used to calculate simple motor diagrams for individual operating points.

Fig. 131: Motor diagrams - Parameters for the creation of the Ld/Lq sets
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For calculation of losses, the required parameters can be entered in the window „Loss Sets“.

Fig. 132: Motor diagrams - Loss sets

A "Nominal Torque + Inductance Calculation" is carried out per Ld/Lq set with subsequent calculation
of the losses.
After calculating the losses, these are read from the individual model files and are also stored in the
"basic" model file. „Re-Read Loss Data from Mot Files = Yes“ is used to read the loss data from the
model files.
A model file (mot-file) is created with the entered data for each Ld/Lq set and stored in the directory
specified in "Working Folder". If the character "" is indicated, the directory is used in which the "base"
model opened with smartFEM is also stored. The respective filenames are supplemented by the Ld/Lq
parameters Is and Theta for distinction.

Fig. 133: Motor diagrams - Example of folder contents with "Base" and "Loss" models
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4.1.1

Performing calculations

By clicking the button, the generation of the motor diagrams is triggered and carried out in the following
steps:
Step 1:

Sequential generation of the Ld/Lq sets from the data specified in the parameter window
„Ld/Lq Sets“. It checks whether the set is already contained in the Ld/Lq table which can be
called in the smartFEM main window via the „Lq-Lq“ button and has already been calculated.
If this is not the case, the set is inserted into the table and the calculation of this set is
started.

Step 2:

When all Ld/Lq sets are calculated, the loss calculations are started (i.e. generation of the
model files (mot files) per Ld/Lq set and execution of the „Nominal Torque + Inductance
Calculations“ with subsequent calculations of the losses Parallel processes corresponding to
the number of processor cores to be used.
In the window „smartFEM MultiRun“ an overview of all Ld/Lq sets and their current state with
regard to loss calculations is displayed. Here, the number of processor cores to be used can
also be adapted from 1 to maximum of the cores present in the particular computer.

Fig. 134: Motor diagrams - smartFEM MultiRun with overview of the current processing status for the loss
calculations

The smartFEM processes started with “MultiRun” run automatically with a lower priority than the
”smartFEM-Master- Process" in order not to block it.
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Step 3:

After completion of step 1, the motor diagrams are generated parallel to the calculation of the
losses. They can be edited by the user and are automatically complemented after the losses
have been calculated.
The values entered in the parameter window "Diagram" are based on:
-

Input Voltage Line to Line or DC
Motor Speed for calculating the minimum voltage Input Voltage Line to Line
Electronic Current Limiter for current limitation. This serves only for the optical
delineation of the operating range, which can be achieved by the maximum motor
current.

The following diagrams are generated:

Fig. 135: Motor diagrams - Diagram types

4.1.2
4.1.2.1

Diagram examples
Torque vs. number of revolutions

Fig. 136: Motor diagrams - Torque vs. torque number of revolutions
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The data entered in the parameter window "Diagram" can be changed after creating the diagrams with
the help of slides shown in the diagram windows, whereby the diagrams are updated immediately.
The dotted lines represent the curve progressions after deduction of the iron, magnetic and external
losses.

Fig. 137: Motor diagrams - Torque vs. Speed with air gap torque (Tag) and output torque (Tout)

By use of the middle mouse button or the scroll wheel individual graphs or groups can be highlighted.

Fig. 138: Motor diagrams - Example of highlighting a single graph
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Each graph can be detached from the tree diagram for user-specific placement on the screen.

Fig. 139: Motor diagrams - Example for "Undock Graph"

Fig. 140: Motor diagrams - Example for "Undock Graph"
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In some diagrams, graphs are also available for minimum values of current and voltage.

Fig. 141: Motor diagrams - Minimum values of the voltage as a function of the current

4.1.2.2

Efficiency diagrams as contour plots

Two different contour plots can be generated to evaluate the efficiency as a function of torque and
speed:

Fig. 142: Efficiency with minimum current

Fig. 143: Maximum efficiency
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The diagrams of the respective mouse position
are shown in the status line, e.g. X = 336rpm, y =
331Nm, η = 97.3%.

Fig. 144: Motor diagrams - Diagram values at the
mouse position

By clicking the right mouse button on the plot, different settings can be made for the plot. The name
"Efficiency" cannot be changed and it is used only for smartFEM internally.

Fig. 145: Motor diagrams - Settings for contour plots
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4.1.3

"Simple" motor diagrams

For a quick assessment of motor properties in individual operating points, "simple" motor diagrams can
be generated. For this purpose "Simple" must be selected in the parameter group "Ld/Lq Sets", in order
to enter the data for the corresponding operating point.

The following diagrams can be
generated:

Fig. 146: Motor diagrams - Parameter input for "Simple motor diagrams"

Fig. 147: Motor diagrams - Example "Simple" motor diagram Us vs. Is with Speed = constant
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4.2

Motor control

The "MotorControl" add-on is used to generate data for the motor control electronics. After entering the
calculation parameters, the unsolved Ld/Lq sets are checked and the corresponding calculations are
then performed.

Fig. 148: Motor Control - Entering the calculation parameters

Different plots are generated, and the results can be stored both in the clip board and in a file.

Fig. 149: Motor Control: Diagrams types
Fig. 150: Motor Control - Result memory
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Diagram examples:

Fig. 151: Motor Control Diagram "Flux Linkage Magnet vs. Is"
Fig. 152: Motor Control - Contour Plot "Torque vs. Theta vs. IS"

Fig. 153: Motor control- Results data
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4.3

General contour plots

The Add-On "ContourPlot" is used to create contour plots from any data compiled by the user.
The data of a contour plot must be stored in a tabular text file (* .txt with tab delimited columns or csv
format). The first cell contains plot, column, and line names each separated by "\".

Fig. 154: Contour Plot - Tabular text file

A single text file or a directory can be selected to generate the plots. When a directory is specified, plots
of all the files contained in the directory are generated.

Fig. 155: Contour Plot example "Efficiency vs. Current vs. Speed"
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5 Simulation in Batch
Batch files enable the sequential and parallel execution of several simulations The respective
command lines for the simulations to be performed can be generated with a text editor. No specific
order of parameters is prescribed.
5.1

Example of batch file with sequential execution of the simulations

ECHO OFF
ECHO smartFEM Batch Mode running, press "CTRL+C" to stop Batch Mode
REM smartFEM Batch Commands for smartFEM Release 2.5.17 and higher
REM
REM
[c:\...\]smartFEM.exe [help | /help | /?] [C:\...\]filename.mot -parameter
REM
REM
If smartFEM.exe and/or mot-file are stored in the folders assigned with
REM
smartFEM settings, then the complete paths are optional.
REM
REM
To display this file as help text [help|/help|/?] can be used.
REM Parameter:
REM
REM
"filename.mot" must be the first parameter, others can be in random sequence.
REM General options:
REM
REM
-log
REM
REM
REM
-hidefemag
REM
REM
-multi1|multi2|...

Text file with log information will be saved with name "filename.log"
in the same folder as the mot-file.
FEMAG windows will be closed and not shown.
FEMAG will run on CPU (or Core) 1|2|...

REM Preprocessing options:
REM
REM
-top
Load mot file with rotor and stator topology saved in mot-file.
REM
REM
-toprotor
Load mot file with rotor topology saved in mot-file.
REM
REM
-topstator
Load mot file with stator topology saved in mot-file.
REM
REM
-dxf
Refreshing of both rotor and stator dxf-files is performed.
REM
REM
-dxfrotor
Refreshing of rotor dxf-file is performed.
REM
REM
-dxfstator
Refreshing of stator dxf-file is performed.
REM Calculation options:
REM
REM
-cogging
REM
REM
-nominal
REM
REM
-is400:-40
REM

Cogging Torque + BEMF Calculation.
Nominal Torque + Inductance Calculation.
Current sine exitation is_rms=400A and phase_shift_theta=-40°el
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REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM
REM

-iq306:-257

Current sine d/q excitation with iq_rms=306A and id_rms=-257A)

-ldlq

Calculation of user defined Ld/Lq sets.

-losses

Calculation of losses with smartFEM "Operational Speed" and
Speed Range defined inside "MotorParameters-PostprocessingLosses", loss results and loss data is saved.

-onlylossresults

Same as "-losses" but only loss results are saved.

-ls=100[:200:300:...]

Calculation of losses at different speed with named speed
-ls=FirstSpeed and optional :SecondSpeed:ThirdSpeeed:etc.

-lsr=0:3000:11

Calculation of losses at different speed with speed range
-lsr=FirstSpeed:LastSpeed:NumberOfSteps.

-ldlq

Calculation of user defined sets of Ld/Lq.

REM Calulation results options:
REM
REM
-export
REM
REM
REM
-export exportfilename.txt
REM
REM
-export folderwithmotfiles
REM
REM
REM
-exportonlyoverview
REM
REM
REM
REM
-save [newmotfilename]
REM

Run batch command and export results from mot-file
to text file with name "filename.txt".
Export of results to user defined "exportfilename.txt" file.
Run all batch command and export of results from each mot-file
inside folder "...\folderwithmotfiles" to "FolderResults.txt"
saved in the same folder.
Run batch command and export only overview table results
from mot-file to text file with name "filename.txt"

Open mot-file, refresh results and save motfile optional
with new mot-file name.

REM Preprocessing will be automatically performed if required.
REM
REM Nominal Torque Calculation will be automatically performed if losses option is selected.
REM
REM ! For correct Nominal Torque results phase angle between BEMF and
REM ! Current has to be checked before calculations are performed, when
REM ! Sinusoidal or User Defined Current is selected.
REM
REM Examples:
REM 1. Perform cogging calculation and write messages to log.
REM D:\...\smartFEM.exe D:\elmoCAD\temp\MotorDesign.mot -cogging -log
REM 2. Perform nominal calculation and calculate losses for speed 7000 rpm
REM D:\...\smartFEM.exe D:\elmoCAD\temp\MotorDesign.mot -nominal -ls=70000
REM 3. Perform nominal calculation and calculate losses for speed 0 rpm until 7000 rpm in steps
REM of 1000 rpm for all mot files inside folder and export results to "FolderResults.txt"
REM D:\...\smartFEM.exe D:\elmoCAD\temp\modelfolder -export -nominal -losses -lsr=0:7000:8
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ECHO OFF
POPD
PAUSE

Fig.

156:

Parameter settings - Sample batch file

If the mot files are stored in the “temp” directory specified with "smartFEM Settings", the path data can
be omitted.
The "Preprocessing" function is performed automatically if necessary.
After starting the batch file, a DOS window is opened, in which the process is documented.

Fig. 157: Parameter settings - Sample Batch log file

The DOS window is closed after all command lines have been executed, unless the DOS command
"Pause" is used in the last command line. The messages sent by smartFEM to the Dos window are
stored in a log file if the -log parameter is used.
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5.2

Exporting result data to a text file

The result data displayed in "Results" are exported to a text file using the batch command "-export",
which in turn can be opened in a spreadsheet for further individual calculations. There are two options
for export:
a) Export the results of a machine model (* .mot file)
Command:

-export c: \ ... \ MotorDesign1.mot c: \ ... \ MotorDesign1_Results.txt
If no paths are specified, the export file is stored in the directory where the mot
file is located.

b) Export the results of a machine model (* .mot file)
Command:

-export c: \ ... \ Motorvarianten Exported_Results.txt

In this example, the results of all machine models located in the c: \ ... \ MotorVarianten
directory are exported to Exported_Results.txt.

Fig. 158: Batch simulation- Exported result file
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5.3

Parallel Computing

If several processor cores are present on a PC, different calculation runs can be distributed to the
existing processor cores for parallel processing. Thus, a considerable amount of computation time can
be saved, especially when, for example, a Nominal Torque Calculation takes several hours.
As exemplary templates, there are two batch files in the batch directory ...\smartFEM\.
5.3.1

_Batch_MultiRun.bat

Here, as in Batch.bat, the calculations are determined and it is defined on which processor core they
are to run:
echo off
rem smartFEM calculations with different mot-files, whereby parallel
rem computing on the existing CPU's or Core's of the PC is performed
rem
rem This batch must be started via _Batch_MultiRunStart.bat
rem
.
.
.
rem Nominal Torque calculation will be automatically performed before
rem calculations if necessary.
.
.
.
rem example:
rem
motfile-1 ... motfile-4 are running parallel on 4 cores
rem
motfile-5 ... motfile-8 are running parallel on 4 cores
rem
rem
motfile-5 is running in sequence after motfile-1 is finished
rem
motfile-6
“
motfile-2
“
rem
motfile-7
“
motfile-3
“
rem
motfile-8
“
motfile-4
“
set exepath=C:\Users\elmoCAD\smartFEM
set motpath=C:\Users\elmoCAD\Temp
set motfile-1=MotorDesignTemp_1.mot
set motfile-2=MotorDesignTemp_2.mot
set motfile-3=MotorDesignTemp_3.mot
set motfile-4=
set motfile-5=
set motfile-6=
set motfile-7=
set motfile-8=
if %1 == -multi1 goto :CPU1
if %1 == -multi2 goto :CPU2
if %1 == -multi3 goto :CPU3
if %1 == -multi4 goto :CPU4
Goto :End
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rem ***********
:CPU1
echo mot-file running on CPU1
echo on
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-1% %1 -log -hidefemag
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-5% %1 -log -hidefemag
Goto End
rem ***********
:CPU2
echo mot-file running on CPU2
echo on
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-2% %1 -log -hidefemag
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-6% %1 -log -hidefemag
Goto End
rem ***********
:CPU3
echo mot-file running on CPU3
echo on
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-3% %1 -log -hidefemag
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-7% %1 -log -hidefemag
Goto End
rem ***********
:CPU4
echo mot-file running on CPU4
echo on
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-4% %1 -log -hidefemag
%exepath%\smartFEM.exe -nominal %motpath%\%motfile-8% %1 -log -hidefemag
Goto End
rem ***********
:End
Pause

The batch must be adapted according to the number of processor cores available on the respective
PC.
This batch must be started by batch file “_Batch_StartMultiRun.bat”
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5.3.2

_Batch_StartMultiRun.bat

Batch calls up the previously described _Batch_MultiRun.bat batch several times according to the
defined number of processor cores, without waiting for the complete execution. The respective
processor cores to be used are transferred as parameters.
The batch must also be adapted with regard to the available number of processor cores of the PC.
echo off
rem smartFEM calculations with different mot-files, whereby parallel
rem computing on the existing CPU's or Core's of the PC is performed
rem
rem This batch will start _Batch_MultiRunStart.bat where mot.files and
rem CPU's have to be assigned
rem
pushd
start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi1
start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi2
start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi3
start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi4
popd
exit

5.3.3

smartFEM

smartFEM can also be started with the following command on a specific processor core directly:
smartFEM.exe -multi # (# = number of the processor core)
However, in this case, calculations can only be performed with the started smartFEM process (no
parallel computing)! With a second parallel running smartFEM process, it is possible to observe results
only.
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5.4

Parameter settings

For motor optimization, a partially automated execution of several calculation runs with varied
parameters for "Cogging Torque + BEMF Calculation" and "Nominal Torque Calculation" can be
performed in batch.
For this, the corresponding parameters must first
be changed in smartFEM and stored in a separate
model file (mot file) for each calculation run to be
carried out.
It is recommended to enable the "Auto-Extension"
function in smartFEM Settings. Therewith, with a
mouse click on the save icon, a mot file with a
unique name can be created for each parameter
variation.

Fig. 159: Parameter settings - Auto-Extension function

For the evaluation and representation of the results of the various calculation runs, programs such as
e.g. Microsoft® Excel can be used. For this purpose, the individual mot files can be opened with
smartFEM and the corresponding results can be copied into the evaluation tools using copy/paste.
Since all the results are stored in xml format in the mot file, they can also be read directly by
corresponding evaluation programs.

Fig. 160: Parameter settings - Example of a graphical representation of results
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6 Special modules
6.1

PM - Magnetization - Inner rotor

The motor type "PM - Magnetization - Inner Rotor" is used to simulate the magnetization and the
remanence of the magnets of a rotor. They are equipped with non - magnetized magnetic material and
subsequently magnetized by means of a magnetizing coil. Two methods are implemented for the
calculation of remanence: a) FEM calculation with FEMAG and b) analytical calculation, which can be
used if the iron core of the magnetization coil is not made of sheet material and very high eddy currents
occur.
Any rotor that can be selected in smartFEM can be used for internal rotors. In the first step, the rotor is
modeled as usual with the corresponding topology.
6.1.1

Rotor and magnetizing coil

For the modeling of the magnetizing coil, a corresponding topology of the stator "MD ... .top" is included
in smartFEM. The number of slots corresponds automatically to the number of magnets defined in the
rotor.

Fig. 161: PM magnetization - Example of Magnetizing
device (coil and rotor)

A material file, which contains a new curve of the "Soft Iron"
magnetic material in the first quadrant as the B (H) curve, must
be selected as the magnetic material in "Material".

Fig. 162: PM magnetization - Initialization

Fig. 163: PM-Magnetization - Magnet Material
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The data for a corresponding new curve B(H) can be recorded using the material Explorer or
PowerCore® Explorer contained in smartFEM.

Fig. 164: PM magnetization - new curve of a neodymium iron boron material

In "Motor Parameters" the data for magnetization simulation are specified subsequently:
-

Min. Rotation Step:
Convergence Accuracy:
Magnetization Current:
Remanence by:

-

Nominal Remanence Brem:
Anisotropy Mode:

minimum step angle for the rotation of the rotor
abbreviation criterion for FEMAG interactions
amplitude of the magnetization current
FEMAG: the remanence induction is determined by FEMAG
MEXFile: the remanence is specified in a "Magnetization
Activation” table.
nominal remanence at the chosen current
isotropic or anisotropic

Fig. 165: PM magnetization - Motor parameters
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The simulation is started by pressing the "Run Magnetization" button,.

Fig. 166: PM magnetization - Start of the simulation with "Run Magnetization"

The simulation results can be displayed and edited as usual in “Plots”, e.g.:

Fig. 167: PM magnetization - Induction distribution

Fig. 168: PM magnetization - Remanence in the
ring magnet (zoomed)

The induction, which is actually reached in air at a certain distance from the magnetic surface, can be
calculated and displayed as a * .mot file in a second step after saving the simulation model.
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6.1.2

Calculation and evaluation of air gap induction and remanence

To assess the magnetization, the air gap induction of pre-magnetized rotors can be calculated and
displayed using a "measuring ring" stator topology (Messring). For this purpose, the previously stored
simulation model of the pre-magnetized rotor is loaded in the rotor topology of a new model through the
dialog "File - Load Magnetization".

Fig. 169: PM magnetization - Charging a pre-magnetized rotor model

Additionally, the stator topology "CS01_Measure_Ring_Magnetization" is selected and correspondingly
parameterized so that it corresponds to a device for measuring the remanence induction of the magnets.
The distance between the measuring probe and the magnet must be equal to the distance of the middle
air gap, so that measurement and simulation results can be compared. If the measurement is carried
out in air, the thickness of the stator ring should be a multiple of the rotor radius in order not to limit the
field propagation in the air by boundary conditions of a ring that is too narrow.

Fig. 170: PM magnetization model for simulating the induction on the rotor surface
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The simulation is started with the "Calculation" button. Additionally, the results (like for example the
calculated air gap induction) can be calculated both with the "BField" plot as well as with "Postprocessing
- Forces and Torque - Calculate" in "Motor Parameters".

Fig. 171: PM magnetization - Induction distribution plot

The remanence induction of the magnets corresponds to the evaluation shown in Fig.112.
The values of the air gap induction (radial and tangential) can be copied via the buffer to a spreadsheet
for further evaluations through "Options - Copy Airgap B-Field Values to Clipboard".

Fig. 172: PM magnetization - Calculating air gap induction by Post-Processing
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Fig. 173: PM magnetization - Air gap induction evaluated in spreadsheets

6.1.3

Use of pre-magnetized rotors in motor models

The simulation models of pre-magnetized rotors saved as * .mot file can be used in motor models. For
this purpose, the corresponding rotor model is loaded in the rotor topology via the dialog "Options - Load
Magnetization" (see Fig. 113).
The geometry parameters of the rotor and the magnetic material can no longer be changed. If
necessary, this must be done as in Tx. 6.1.1 and the rotor can be magnetized again.
All other functions for the simulation of the motor model with pre-magnetized rotor are available as usual.

Fig. 174: PM magnetization - Motor model with biased rotor
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6.2

PM DC Brushed Motor

The creation of a simulation model PM DC Brushed Motor is initialized via "File - New - Select Motor
Type". The topologies correspond to those of the outer rotor motors. At least one PM-BDLC outer rotor
topology (* .top) must be stored in the topology directory in order for menu item "PM DC Brushed Motor"
to be displayed.

Fig. 175: PM DC motor initialization

All outer rotors and stators can be selected.

Fig. 176: PM DC motor - Example of a geometry model
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6.3

Switched Reluctance Motor

The creation of a SR motor model simulation is initialized via "File - New - Select Motor Type". At least
one SR rotor topology (* .top) must be stored in the topology directory in order to display the „SR - Motor“
menu item.

Fig. 177: SR motor initialization

The rotor topology of an SR motor differs from that of a PM motor in that only rotors without magnets
can be selected.

Fig. 178: SR motor - Example of a geometry model
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In „Motor Parameters“, the current can be specified as "User Defined Phase Current".

Fig. 179: SR motor - User Defined Phase Current

Because the phase positions of the windings of a SR motor cannot be determined from motor topology
and winding scheme, a torque calculation with a constant current is performed for each phase. The
maxima of torques then correspond to the respective phase position. To perform this calculation, the
"ReCaculate Phase Current" button must be clicked in “Motor Parameters”. Subsequently, at the next
"Nom. Torque + Inductance" calculation, the phase positions are calculated before and displayed in
"Motor Parameters".

Fig. 180: SR motor - Determination of phase positions
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The simulation results are then displayed in the same way as described in the previous chapters.

Fig. 181: SR motor - Results
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6.4

Synchronous Reluctance Motor

The creation of a SR motor simulation model is initialized via "File - New - Select Motor Type". At least
one SR rotor topology (* .top) must be stored in the topology directory in order to display the „SR - Motor“
menu item.

Fig. 182: Synchronous Reluctance Motor -Initialization

A motor model with 4 poles and 4 flow barriers (rotor topology CR_31_Synchronous_Relectance) is
displayed.

Fig. 183: Synchronous Reluctance Motor - 4 poles
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Rotor topology CR_33_Synchronous_Reluctance with 2 poles

Fig. 184: Synchronous Reluctance motor - 2 poles
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6.5

Universal motor

The creation of a Universal Motor model simulation is initialized via "File - New - Select Motor Type". At
least one universal rotor topology (* .top) must be stored in the topology directory, so that the menu item
„PM - Universal Motor“ is displayed.

Fig. 185: Universal motor initialization

The modeling of a universal motor does not differ from the modeling of the other motor types apart from
the rotor and stator separated windings and the setting in „Motor Parameters“.

Fig. 186: 2-pole universal motor with 24 rotor slots
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After "Preprocessing", the following calculation can be performed:
-

Creation of plots of induction with/without rotor (or armature) and stator currents for the design
of the magnetic circuit

Fig. 187: Universal motor - Plot of induction and field lines

DC and AC motors can be simulated via the settings in "Coil Examination - Current Parameters". The
simulation is performed in several steps:
-

Calculation of the commutation sequence ("Commutation Sequence")
Calculation of torque during commutation („Switching Torque“) Determination of the torque
Calculation of torque in AC or DC operation ( "Motor Torque")
Calculation of the rotor position for the positioning of the brushes

Fig. 188: Universal motor - Motor parameters
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6.5.1

Calculation of "Commutation Sequence"

Since because of the missing magnets, "Cogging Torque + BEMF" cannot be determined, the "Nominal
Calculation" is only possible without/with loss calculation. First, the basic parameters are set in "Motor
Parameters" and the first simulation step "Commutation Sequence” is selected. The following
calculations are performed after clicking "Apply" and "Calculation" buttons:
-

Excitation of the field winding with DC current (amplitude) at high armature speed.
Simulation without armature currents to determine the flux per winding depending on the
winding scheme.
Simulation with rotation of the armature.
Determination of the induced voltage („Transformer Voltage“) in the armature windings and
their phase positions.
Definition of the commutation sequence on the basis of the induced voltages.
Determination of a first brush position based on the induced voltage or flux in the windings
for a given armature position (windings with maximum flux or minimum induced voltage,
respectively, begin to commute).

After performing this simulation step, the phase positions of all windings are shown in "Motor
Parameters". Coil no. 13 in slot 01 on the right and slot 13 on the left have the phase position 0 ° el.

Fig. 189: Universal motor - Position of the winding 13

Fig. 190: Phasing of the coils
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In "Results“,the following
graph, among other things, is
dosplayed:
"Transformer Voltage per
phase": the graph for slot no.
13 (phase position 0 ° el with
the individual calculation
points) is highlighted in
green.

Fig. 191: Universal motor - Transformer Voltage per rotor phase (Rotor Current = 0A)

6.5.2

Calculation of torque during commutation "Switching Torque"

The settings are made in "Motor Parameters - Calculation Steps". Among others can following graphs
be displyed in "Results":
For the chosen example with 2 stator slots and 24 rotor windings are the calculations
performed across the rotor positions 0 - 15°mech.

Fig. 192: Switching Torque - Stator currents

Fig. 193: Switching torque - Rotor currents
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Fig. 194: Switching
Torque - Torque

6.5.3

Calculation of torque in AC or DC operation "Motor Torque"

For DC operation, constant current must be selected in "Motor Parameters - Coils Excitation". For the
results shown below, sinusoidal current was set, i.e., the simulation was performed as of an AC motor.
The unit of the abscissa is given in the time domain - in the example, the period of the sinusoidal stator
current is 20 ms corresponding to a frequency of 50 Hz.

Fig. 195: Motor torque - Stator
currents

The rotor currents from i_C 01 to i_C 13 have the same phase position. The rotor currents from i_C 14
to i_C 24 also have the same phase position but an offset by 180 ° el compared to the previously
mentioned one.

Fig. 196: Motor Torque - Rotor
currents
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Fig. 197: Motor Torque - Torque of the AC motor

6.5.4

Calculation of the rotor position for the positioning of the brushes

For the calculation of the optimal position of the brushes, different brush positions, calculation angles
and commutation lengths can be set via the menu sequence "Motor Parameters - Coil Excitation Current Parameters". "Motor Torque" is selected in "Calculation Steps". The results are displayed as
usual in the diagrams in the "Results" menu.

Fig. 198: Universal motor - Positioning the brushes
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6.6

PM - Linear motor

The creation of a linear motor simulation model is initialized via "File - New - Select Motor Type". At least
one linear motor topology (* .tol) must be stored in the topology directory so that the menu point „PM Linear Motor“ can be displayed.

Fig. 199: PM-Linear motor -Initialization

The modeling of a linear motor differs from the modeling of the other motor types only that rotor geometry
and stator geometry are parameterized in a "Geometry" topology. All other functions are the same except for the calculation of the iron and magnetic losses and motor diagrams.

Fig. 200: PM -Linear motor - Example of a geometry model
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Fig. 201: Linear motor - Representation of forces and air gap induction
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7 Interfaces
7.1

Export of result data als tabled text

All result data can be copied into other software tools by „Copy/Paste“ and partly also can be saved
directly in tabled text files.
Examples:

Fig. 202: Export of result data as text - Cogging Torque

Fig. 203: Export of result data as text - Model Data
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7.2

Documentation “Project Report”

smartFEM offers the possibility to create a project report by menu „File“→“Generate Project Report“,
which is saved in a RTF-formetted textfile and can be edited by popular text programs. The contents
of the report (design data, calculation results, and diagrams) can be selected by the user.
The diagrams can be selected at the related simulation results:

Fig. 204: Project Report - Selection of diagrams

Diagrams in general and design parameter and calculation results as text can be selöected in a popup windows after selction of the menu “Generate Project Report“:

Fig. 205: Project Report - selection of design parameter and results as text
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Example:

Fig. 206: Projekt Report opened by Microsoft® Word
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7.3

FEMAG

smartFEM uses FEMAG for the numerical calculation of all the results, which are determined on the
basis of the finite element method (FEM). For this, smartFEM transfers all necessary information to
FEMAG and controls all FEMAG processes
•

to create the simulation model required for analyzing and evaluating the numerical
computations - triggered by pressing the "Preprocessing" button.

•

to perform all analyzes and evaluations - triggered by pressing the "Calculation" button.

smartFEM receives all relevant data from the FEMAG results files for further calculations, evaluations
and graphical representations.
Running FEMAG processes can be contolled and aborted at any time by pressing the "Calculation
Running" button without losing any data.
The user can start FEMAG at any time directly by pressing the "FEMAG" button. It will be used in the
version that was previously set through "Tools → smartFEM Settings → User FEMAG Exe File". By
clicking on the „FEMAG“ button with the right mouse button, a following selection menu is offered:

Fig. 207: Starting FEMAG from smartFEM

•

"Empty FEMAG"
FEMAG is started. The user can create a new FEMAG model or edit an already existing one.

•

"Copy Preprocessing Files With Name" PreFile ""
The current smartFEM model is available as a copy in the specified FEMAG directory under the
names "Prefile.a7" and "PreFile.i7". At the same time, FEMAG is started and the user can load
and edit the model using the FEMAG command "Select Input File". Changes and evaluations to
the model made by the user are not accepted by smartFEM.
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7.4

CAD

For the import of rotor and stator geometries created with CAD systems, special topologies have been
implemented which allow the import of geometry data in the DXF or CSV format:
-

Internal motor
o CR_CADdata.top
o CS_CADdata.top

-

External motor, brush motor
o OCR_CADdata.top
o OCS_CADdata.top

-

Switched Reluctance Motor
o SR_CADdata.top

-

Sychronous Reluctance Motor
o SyncRel_CADdata.top

-

Universal motor
o UR_CADdata.top

-

Linear motor
o LM_CADdata.top

First they have to be opened like the "usual" topologies, before an import file can be selected.

7.4.1

DXF Import

The basis for the implementation of the DXF interface is the documentation named
"Autodesk_2011_dxf_reference_v.u.25.1.01" by Autodesk, Inc., USA.
The entities "POINT“, “LINE“, “LWPOLYLINE“, “ARC“, “CIRCLE“, „TEXT“ und „MTEXT“ with smartFEM
relevant data are selected from the DXF files and all the information required for the simulation is
generated:
- POINT:

The origin P(0) of the smartFEM coordinate system has the coordinates x = 0
and y = 0 and represents the center point of all rotor and stator geometries.
Note:
If the origin of the coordinates exported to a DFX file from a CAD system is
not at the center of the rotor or stator geometry (= intersection point of the
right and left sector line of the pole), an additional point in this point has to be
created in the CAD.

- ARC,
CIRCLE,
LINE:

Out of the the selected information, the start and end points are generated.
For arcs and circles, the center points are generated and numbered form 1
to n, taking a „PickPointRadius“ into account.
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- TEXT:

The following texts are required as additional information in smartFEM:

Keyword

Parameter

Description

Type of Motor

= PM - Inner rotor

Motor type:

Position

PM Inner rotor

= PM - Outer rotor

PM outer rotor
PM brush motor

= SR - Motor- inner rotor

Reluctance motor

= Universal motor

Universal motor

= PM - Linear motor

PM_Linear motor

= Rotor

Geometry type: Rotor

= Stator

Stator
Note: When linear motors are concerned,
the geometries below the air gap are
defined as "Rotor", and those above as
"Stator"

Optional keywords
Not used keywords
have the value = False

[…] = default value if no
parameter is specified

HalfPole

[= True]

The geometry describes a half pole and is
mirrored in the FEM model.

CompletePole

[= True]

The geometry describes an entire pole. It is
not mirrored in the FEM model.

= [True;] Asymmetric

The geometry describes a whole
geometrically unsymmetrical pole.

[= True]

The pole geometry is mirrored in the FEM
model.

= False

The pole geometry is not mirrored.

SegmentedGeometry

[= True]

A segemnted geometry with n poles per
segment.

CompleteGeometry

[= True]

The complete geometry with all stator and
rotor poles (360 °mech). It can be nonsymmetrical with respect to the individual
poles and thus non-periodic with respect
to the BEMF. It is adopted without changes
to the FEM model. The FEM calculations

MirrorPole
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are performed with 360 °mech rotation of
the rotor.
= [True; Periodic]

The complete geometry is periodic with
respect to the BEMF. The FEM calculations
run over the BEMF period [° mech].

The following texts is required to assign type of material to areas. The anchoring points of the text boxes
must lie in the corresponding surface elements. Many parameters have to be separated by the character
semicolon ";". No specific order of parameters is prescribed.
Keyword

Parameter

Magnet

Material = Magnet
[; MaterialNo = #]
or [; MatNo = #]

Material number according to the material
data defined in "Materials" for the model.

[; Length = #.##]

Relative magnetic length in the axial zdirection [% of the motor length “Lmot”]

[; MagAngle = #.##]

Angle of the magnetization direction with
respect to the x-axis [°mech]

Steel

Coil

[Air]

Description

Material = electrical sheet
[; MaterialNo = #]
or [; MatNo = #]

Material number according to the material
data defined in "Materials" for the model.

[; Length = #.##]

Relative length in the axial z- direction [% of
the motor length Lmot]

[; MaterialNo = #]

Material = coil

[; MatNo = #]

Material number according to the material
data defined in "Materials" for the model.

[; SlotSideIndex = #]

Indicate on which side the slot lies in the
coil.
Material = air

The areas defined in this way can be selected in the geometry window of the topology with the mouse
and be edited. Areas without an assigment of a material type are treated as air.
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Optional parameters
The following texts may be included. If no information is contained, smartFEM automatically calculates
these values from the selected geometry points.
Note:
External radii must correspond to the maximum or minimum distance between the center point and the
outer or inner contour of the respective geometry. If the contours are not circular-shaped, it is possible
that the radii on the sector lines of the pole segments cannot be determined from the geometry points.
In this case, they must be specified.
Keyword

Parameter

Description

Rro =

#.###

Outer radius rotor

Rri =

#.###

Internal radius rotor

Rso =

#.###

Outer radius Stator

Rsi =

#.###

Internal radius Stator

Np =

##

Number of poles for rotor or stator
according to "Position"

alternative Ns =
i.e. Nm =

##
##

Number of stator slots
Number of magnet poles

Node distances or number of segments can be specified as follows for lines and arcs. The text boxes
must be positioned in such a way that the anchoring points lie as close as possible to the respective
lines or arcs.

NDistFact =
or NDist =

#.#### (default: 1.0)

Factor for setting the knot density = Bna *
NDistFact = Bna * NDist

NDistFactNlin =
or NlinDist =

#.#### (default: 0.0)

Factor for determining a nonlinear node
density on the lines.
In case of a positive factor and positioning
of the text box closer to the end point of the
line, the node density is distributed from low
to high in the direction from start to end
point, in the case of a negative factor or
positioning closer to the starting point in the
opposite direction.
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NSeg =

###

Number of segments, into which line and
circular arcs are divided by the nodes.

Other optional parameters

MiddleSlotLine

Marking the line, which divides the slot in
the right and left side in unbalanced
geometries.

NCoils =
NCoilsPerSlot =

1 or 2, default = 2

One or two-layered coil
Coil in the left/right slot half

CoilsLayer =

UpDown

Coil in upper/lower slot half (only for twolayered coil)

RingCoils

Ring coil around the stator back

NSlotsPerSegment

##

Number of slot per segment in segmented
geometries („SegmentedGeometry”)

NPhases =

##, default = 3

Number of phases

Bna =

#.###, default: = 1.0

BasicNodeAngle = minimum angle between
two nodes on the air gap

Dp =

#, default = 2

Number of decimal places for the rounding
of the entered and displayed parameter
values

With the help of the CAD program "Solid Edge 2D-Drafting" from Siemens PLM Software, text can also
be assigned to the respective lines, arcs, etc. by means of a text bubble.
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7.4.2

Using Layers in the CAD Model

If the CAD model should contain more information than the dfx import basics (e.g., guidelines,
dimensions, etc.), layers must be used. The drawing objects and text required for the DXF import to
smartFEM must be contained in layers that on their part contain the word "smartFEM". Several
"smartFEM" layers can be defined. All other information must be drawn in other layers. If no layers are
used, the CAD model is allowed to contain only the information required for the smartFEM DXF import.

Fig. 208: CAD Import - Using Layers
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7.4.3

Example of stator geometry

Fig. 209: CAD import - Example stator geometry

smartFEM detects the position in the xy-level and rotates the topology so that it is displayed as the
"usual" standard topologies.
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7.4.4

Example of rotor geometry with node densities

Fig. 210: CAD Import - Example of a rotor geometry

Arrangement of node densities information can be done with the help of text boxes and text bubbles.
Currently, only text bubbles in Solid Edge 2D drafting by Siemens PLM software are available and can
contain different start/end symbols (e.g. arrow, circle, etc. without bending lines).
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7.4.5

Example of a complete stator geometry

Fig. 211: DXF import - Complete geometry

7.4.6

Example of a complete stator geometry with offset

If a line is drawn at the zero point of stator geometry, an eccentricity between rotor and stator is
generated in smartFEM according to the length and direction of the line.

Fig. 212: DXF Import - Eccentricity between rotor and stator
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7.4.7

Functional description of import

After selecting the CAD_Rotor or CAD_Stator topology, an empty geometry and parameter window is
displayed as well as a selection window for selecting a DXF or CSV file.

Fig. 213: CAD import - Selection of the DXF or CSV
file

After selecting the corresponding file, the import is performed toherther with the construction of geomerty
and the display of the parameter list:

Fig. 214: CAD import - Example of imported stator geometry

The information about individual lines, arcs, etc. can be specified by entering their index number. In
addition to the numeric information in the parameter list, context-sensitive auxiliary information is
displayed in the graphics window.
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Fig. 215: CAD import - Information on geometry elements

Entering the line, arc, area and point numbers displays additional information. The node distances can
be changed for each element.
Example:
- Bow:
- Center point:
- Starting point:
- Endpoint:
- Factor for minimum Node distance:
- Radius:
- Opening angle:

A5
16
18
17
0.5
(Node distance = factor * basic node distance)
1 mm
97.73 °

In the "Geometry" and "Nodes" view of the graphics window, individual elements can also be selected
with a right mouse click on the corresponding element.

Fig. 216: CAD import - Selection of a geometry element
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7.4.8

Pre-requirements and error notes

When creating DXF or CSV files, the following points have to be considered, so that smartFEM can
build up a simulation-capable geometry model.
7.4.8.1

Free surface elements

The geometries must not contain any surface elements (islands) that are not connected to another
surface element by a line or circular arc.
If this is still the case, the corresponding surface element is displayed with a red border in the geometry
representation, an error message is displayed and the "Bad Geometry" button is displayed instead of
"Apply". A connection must then be established in the CAD system and the import performed again.

Fig. 217: CAD import - Free surface elements

7.4.8.2

Unique points

Rounding differences in the creation of the DXF or CSV files for the import can lead to the possible
situations where the same points have different xy-coordinates and are recognized as two points. To
prevent this, the minimum distance between two points „MinDist“ can be specified as a parameter in
the parameter group "Basic". xy-coordinates which have a smaller distance to each other are then
recognized as one point.
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7.5

DXF Export

The geometries created with smartFEM can be exported in dxf format in two different ways, in order to
be used with other programs:
-

Export from the respective topology window
A complete geometry model including all related information as text for e.g. CAD systems for
changes to geometry and/or text parameters with subsequent re-import into smartFEM

-

Export via the smartFEM main menu
Various types of geometry model for e.g. CNC machines for sheet metal cutting
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7.5.1

Export from the respective topology window

This function is called up via the menu "File - Export Topology to DXF" specified in the topology window.

Fig. 218: DXF export topology

The user can specify in which directory the DXF file should be stored. Different layers with the term
"smartFEM ..." are created for the respective information types. Text size of the of node distances are
adjusted to the respective lengths of the lines and arcs.
After being opened in a CAD system, geometry and text parameters can be modified and, after saving
as a DXF file, imported back into smartFEM with the corresponding CADdata topology (in this example
CR_CADdata).

Fig. 219: DXF export representation in a CAD system
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The 2D-Model of the CAD system can contain any drawing and text information. The information
required for the import into smartFEM and only these must respectively can be contained in layers that
contain the text "smartFEM".

Fig. 220: DXF export - smartFEM layer in 2D model of the CAD system

7.3.2 Export via the smartFEM main menu
With this function, only geometric data is exported to a DXF file in the smartFEM geometry file
according to the respective view:
-

Rotor
Stator
Periodic model
FEM model

additionaily, e.g. for the programming of CNC machines
- Export Material Contours
- Export Steel Material Contours

Fig. 221: DXF Export - Example stator geometry
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Fig. 222: CAD export - Function selection

Fig. 223: DXF Export - example: Contour of the stator laminated core

To export the entire model, the winding editor must be opened by clicking on the "Winding Defined"
button. The entire model is then displayed and can be exported with "File - DXF Export - Periodic Model".
Uneccessary drawing lines need to be removed in CAD system, so that only e.g. the contours can be
further processed.

Fig. 224: DXF export - Entire machine model

Fig. 225: DXF export - Material contours
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7.6

CASPOC

For simulation of motor control with the simulation tool for power electronics CASPOC1, the parameters
required for Ld/Lq calculation can be generated directly via the "Data- Caspoc - Add Sets" dialog and
then calculated using "Solve All".

Fig. 226: CASPOC calculation parameters

Subsequently, the generated result table with further results data can be stored in a XML formated file
which can be processed directly by CASPOC.

Fig. 227: CASPOC - Saving of the results data to an export file

The file contains the following data:
Motor parameters
- stator inductance Ld
- stator inductance Lq
- Winding resistance
- moment of inertia of the rotor
- number of pole pairs
Data table1
- Rotor position [° mech]
- Phase shift current [° el] (not used = 0)
- Amplitude of current (not used = 0)
- Torque (= locking torque)
- ke1 Voltage constant phase U
- ke2 Voltage constant phase V
- ke3 voltage constant phase W
- flux linkage 1
- flux linkage 2
- flux linkage 3

1

CASPOC is a product of Simulation Research, NL - Alphen aan den Rijn
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Data table2
- Rotor position [° mech] (=0)
- Phase shift current [° el]
- Amplitude of the current
- Torque
- ke1 voltage constant phase U (not used = 0)
- ke2 voltage constant phase V (not used = 0)
- ke3 voltage constant phase W (not used = 0)
- Ld
- Lq
- flux linkage 3 (not used = 0)

Fig. 228: CASPOC example XML file
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8 Notes
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